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Section 1.1 
About This User Manual 

 
1.1.1 The Purpose of This Manual 

 
Audience This User Manual is intended for designers utilising the TraSiS V.V3.0 software 

program for the design of roadside sign support structures. 

 
Scope The User Manual describes the process involved to: 

• Create a new sign structure; 
• Understand the sign storage feature; 
• Print forms; 
• Interpret warnings and errors; and 
• License the program. 

 
Reader Skills The User Manual assumes that the reader has a basic knowledge of: 

• Personal computers and their operation; and 
• The sign design procedures as outlined in the Design Guide for Roadside 

Signs. 

 
Expected 
Outcome 

After studying this manual, the reader should be able to: 

• Create a new sign structure; 
• Understand the sign storage feature; 
• Print forms; 
• Interpret warnings and errors; and 
• License the program. 

 



Traffic Sign Structures (TraSiS)  
User Manual 
 

  

 

 Chapter 1 – Introduction to the Manual TraSiS - User Manual 8 

1.1.2 How to Use This Manual 

 
Composition This manual is divided into eight chapters to group together related subject 

matter. 

 
Chapter 1 Chapter 1, Introduction To The Manual, explains: 

• The purpose of the manual; 
• The typing conventions and acronyms used in the manual; and 
• Where to obtain further information relating to traffic sign structures. 

 
Chapter 2 Chapter 2, Introduction to TraSiS: 

• Install TraSiS software; 
• Open the program; 
• View the Main Window; and 
• Access the various menus. 

 
Chapter 3 Chapter 3, Design Procedure, provides sufficient information to the user to: 

• Create a new sign file; 
• Complete the Sign Details Entry Form; and 
• Complete the Roadside Environment Entry Form. 

 
Chapter 4 Chapter 4, Main Window, explains: 

• The layout of the Main Window; 
• How to enter the sign design data on the appropriate forms; and 
• How the Message Box is used for warnings and errors. 

 
Chapter 5 Chapter 5, Sign Storage explains how to use the: 

• Database storage system; and 
• Job management feature. 

 
Chapter 6 Chapter 6, Clear Zone explains: 

The clear zone concept; and 
How to complete the Clear Zone Form. 

 
Chapter 7 Chapter 7, Printing, describes the three forms available and explains how to 

print the various forms. 

 
Continued on next page 
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1.1.2 How to Use This Manual, (continued) 

 
Chapter 8 Chapter 8, Warnings and Errors, explains how warnings and errors are 

communicated to the user through the Message Box. 

 
Keyboard 
Shortcuts 

The Keyboard Shortcuts lists the available shortcut keys and their function. 

 
Licensing The Licensing explains how to license the software and how to transfer a licence. 

 
Glossary The Glossary contains an explanation of terms used throughout the manual. 

 
Index  The comprehensive Index at the end of the manual is provided to assist in 

locating topics and their page numbers, with cross-references to other topics 
where applicable. 

 



Traffic Sign Structures (TraSiS)  
User Manual 
 

  

 

 Chapter 1 – Introduction to the Manual TraSiS - User Manual 10 

1.1.3 Typographical Conventions Used in This Manual 

 
Typographical
Conventions 
Table 

The following table explains the typing convention used in this manual: 

CCoonnvveennttiioonn  MMeeaanniinngg  EExxaammppllee  
Bold Names of menu names, items, 

buttons, utilities and text entry 
fields. 

Select the Open command. 
Click on the Browse button. 

System data System text displayed on your 
screen.  This font is also used for 
file names and directories. 

Do you wish to rebuild printers?  
(Y/N) 

Italics Cross-reference to other manuals, 
chapter and Appendices in the 
documentation. 

Refer to the 
Design Guide for Roadside Signs 
for more information. 

entry data Commands that should be 
entered exactly as shown appear 
in this boldface type. 

Enter the following: 
A:\setup  

dir newdir Information that you must supply 
is in bold, lower-case italics. 

Enter the command: 
Copy  olddir newdir  

<Del> Keys to be pressed are shown in 
the <and> brackets. 

Press <F3> to call up the wizard. 

X > Y > Z Menu items to be selected in 
sequence (usually clicked on 
using the mouse) are separated 
by the symbol “>” 

View > System Status > 
Channels. 

<Ctrl>+<C> Keys to be pressed 
simultaneously are shown with a 
+ (plus) sign. 

To close the window, press  
<Ctrl>+<C>. 

 
Important 
Messages Important messages are highlighted in this manner 
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1.1.4 Acronyms Used in This Manual 
 

Acronyms List  The following acronyms are used in this manual: 

AAccrroonnyymm  DDeettaaiillss  
AADT Annual Average Daily Traffic Flow 
CHS Circular Hollow Section 
RHS Rectangular Hollow Section 
TraSiS Traffic Sign Structures 
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1.1.5 Related Documents 
 

Document List  The following lists all related documents: 

DDooccuummeenntt  DDeettaaiillss  
1 Standard Drawing Number 1363 – Traffic Sign Support 
2 Standard Drawing Number 1364 – Connection Strap and Erection 

Details 
3 Standard Drawing Number 1365 – Traffic Sign Support Breakaway 

Post Details (2 or more supports) 
4 Standard Drawing Number 1366 –Traffic Sign Support Detail –Truss 

Type Breakaway 
5 Standard Drawing Number 1367 –Traffic Sign Support Detail –Truss 

Type Breakaway Bracing Details 
6 Standard Drawing Number 1368 –Single Traffic Sign Support 
7 Standard Drawing Number 1450 –Traffic Sign Support Timber Posts 
8 Standard Drawing Number 1451 –Timber Support Details 
9 Main Roads Guidelines ES-126, Appendix 3 
10 Design Guide for Roadside Signs, Edition 1, Rev 0, February 2000 

 
End of Chapter 1 
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Section 2.1 
About This User Manual 

 
2.1.1 Introducing TraSiS 

 
What is TraSiS TraSiS v.V3.0 is a program developed by the Traffic Engineering & Road Safety 

Section of Main Roads, to assist in the design of roadside sign support structure. 
It is used in conjunction with the companion document Design Guide for Roadside 
Signs. 

 
Installing 
TraSiS 

Insert the CD ROM or download "trasis.exe" from Main Roads web site 
www.mainroads.qld.gov.au to an appropriate directory.  From that directory/folder 
select the  "trasis.exe" file.  The Welcome screen will appear.  Close all other 
applications and click Continue to proceed with the download. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Close all other applications then click the Continue button. 
 
 
 
 

 
Continued on next page 
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2.1.1 Introducing TraSiS, (continued) 

 
Installing 
TraSiS (cont’d) 

When the downloading is complete you will see the following screens. The 
program will automatically download and create new default folder called Main 
Roads located on your hard drive. Select Next or an appropriate installation 
folder (Browse for folder).  Then simply click Finish to complete the download. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Click Finish to 
complete download 
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2.1.2 The Main Menu 

 
Main Menu 
Description 

Once the program is loaded, the Title Bar becomes active and the menus 
available 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Menu Bar The Main Menu provides the user with 

access to the: 

• File menu; 

• Edit menu; and 

• Help menu. 

 

Title Bar 

Menu Bar 
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2.1.3 Menus 

 
Main Menu 
Description 

If a first time user, take some time to 
become familiar with these menus. 

 
File Menu New: 

Create a new sign. 
 
 
 
 
 
 
 
 Open: 

Open a previously created file. 

 
 
 
 
 
 
 
 Close 

Close the current sign. 

 
 
 
 
 
 
 
 Save 

Save the current sign. 

 
 
 
 
 
 
 

 
Continued on next page 
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2.1.3 Menus, (continued) 
 

File Menu 
(cont’d) 

Save As: 
Save the new sign in the current 
database. 

 
 
 
 
 
 
 Rename: 

Rename a sign, job section or an entire 
job, see 5.1.1. 

 
 
 
 
 
 
 Delete: 

Delete a previously saved file. 
 
 
 
 
 
 
 
 Print: 

Print out a Design Form, Order Form
or Summary Form. 

 
 
 
 
 
 
 Exit: 

Exit the TraSiS program. 
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2.1.3 Menus, (continued) 

 
Edit Menu The following information is available 

from the Edit menu: 

 
 Sign Details: 

Edit the current job description, sign 
faces and roadside slope, see 3.1.1. 

 
 
 
 
 Environmental Conditions: 

Specify wind region, foundation ground 
type and situation risk, see 3.1.2. 

 
 
 
 
 Stiffener Spacing: 

Use DMR standard (ES – 126) or 
customised settings, see 4.2.3. 

 
 
 
 
 Notes: 

Assigns general comments and notes. 
These notes are printed with the 
Design Form, see 7.1.1. 

 
 
 
 
 Clear Zone: 

Calculates the appropriate clear zone 
distance for the road, see 7.1.1. 

 
 
 
 Default Values 

Assigns default values to Sign Position 
and Clear Zone parameters, see 7.1.1. 

 
 
 
 

 
Continued on next page 
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2.1.3 Menus, (continued) 

 
Edit Menu 
(cont’d) 

Default Values: 
Assigns default values to sign position 
and clear zone parameters 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Help Menu The following information is available from the Help Menu 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
End of Chapter 2 
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Section 3.1 
Design Procedures 

 
3.1.1 Sign Details Entry Form 

 
To begin From the File menu or the Main Window select the New command.  This 

launches the Sign Details Entry Form 

 
 
 

 
 

 

 
End of Chapter 3 

 
Job Details All information boxes must be filled in before proceeding to the next tab. 

Use the Previous and Next buttons to navigate between the three tabs. 

TraSiS stores all signs in a database. Each sign is distinguished by job, section, 
and sign position (location), allowing for simple and effective organisation of sign 
storage. 

A Status area indicates possible duplication of name allocations and validation of 
new design. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Continued on next page 

Three tabs will be visible: 

• Job Details; 
• Roadsides Slope; and 
• Sign Panels. 
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3.1.1 Sign Details Entry Form, (continued) 

 
Roadside 
Slope Details 

Define the roadside geometry. 

Up to five slope segments of variable length and height can be used to model a 
particular roadside cross-section.  In addition, the longitudinal details of the slope 
segments can be specified (this is useful when examining the feasibility of strut 
sport signs, for example where there are longitudinal differences in post location). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Continued on next page 
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3.1.1 Sign Details Entry Form, (continued) 

 
Sign Panels Specify the details of the sign face. 

A sign structure can support up to four separate panels (three facing the front and 
one facing the rear), each panel having individual dimensions, road clearance and 
colour.  Refer to the Design Guide for Roadside Signs 3.1 for information 
regarding sign face design. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Once all sign details forms are complete, the OK button becomes available. 

Clicking on it launched the next form, Roadside Environment. 

 

Click the OK button to 
move to the next form. 
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3.1.2 Roadside Environment Entry Form 

 
To Begin Once all Sign Details forms are complete and the OK button clicked, then the 

Roadside Environment form will appear. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Wind Region Select which geographic wind region the sign is to be built in. 

The wind region scale is from A to D, A being for areas which generally 
experience normal wind conditions and D being for areas that are subject to 
severe cyclones. 

 

 

 

 

 

 

 

 

 

 

The wind region map indicates the geographic regions associated with the scale. 

Locations that are exposed to higher winds than what is usual for the locality (e.g. 
coastal highways) are accommodated for by selecting the Exposed Location
check box.  Refer to the Design Guide for Roadside Signs, 2.9. 

 
Continued on next page 

Click on the Guide 
to Wind Regions 
button for the map of 
Wind Regions 

Three tabs will be visible: 

• Wind Region; 
• Soil Type; and 
• Slip Base. 

Click the OK button to 
move to the next form. 
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3.1.2 Roadside Environment Entry Form, (continued) 

 
Soil Type Select the soil type that most accurately describes the soil at the location: 

1. Cohesive Clay Soils; or 

2. Cohesionless Sand Soils. 

 

 

 

 

Reference can be 
made to Guide to 
Foundation Strength 
Selection by clicking 
on the button. 

A description of each 
type (field and scientific 
identification) will assist 
in the selection of the 
appropriate soil type. 

 

 

 

 
Four tabs will be 
visible as described 
bellow. 

1. Clay Soil – Firm to Stiff; 
2. Clay Soil – Stiff to Hard; 

3. Sand Loose to Medium Dense; and; 

4. Sand – Dense. 

 
Continued on next page 

Click the OK button to 
move to the next form. 
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3.1.2 Roadside Environment Entry Form, (continued) 

 
Soil 
Description 

Select the soil type that most accurately describes the soil at the location: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Continued on next page 

Click the OK button to 
move to the next form. 
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3.1.2 Roadside Environment Entry Form, (continued) 

 
Slip Base If the sign is to be erected in an area where there is a high risk of impact (ie within 

the clear zone distance), see 7.1, select Slip Base.  Otherwise select Rigid 
Base. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
End of Chapter 3 

 

Click the OK button to 
continue. 

Refer to the Design 
Guide for Roadside 
Signs, 8.3.4 for further 
information. 
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CHAPTER 4 

MAIN WINDOW 
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Section 4.1 
Understanding The Window 

 
4.1.1 Introducing Main Window 

 
What is 
Displayed 

The Main window gives a clear display of the most important elements of the sign. 
The left half of the screen displays technical design data, while the right half 
displays a graphic view of the sign in relation to the ground and road. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Data Field 
Adjustment 

 

 

 

 

Some of the data fields on the left-hand side 
are variable within a certain range. 

Pressing the square button launches a small 
dialog box where adjustments can be made 
to the field parameter. 

 
 

 

 

Post Type 

Message Data Fields Status Bar 

Adjustment Buttons Title Bar Menu Bar 

Sign ID 

Graphic View Technical Design 
Data 
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Section 4.2 
Technical Design Data 

 
4.2.1 Support Details 

 
Number Details the number of support posts. 

Clicking the square button will 
launch the dialog box.  The 
number of posts may be varied 
within a certain range by clicking 
the increase or decrease triangles

 

 

 

 

 

 

 

 

Instructions will appear on the Status Bar. 

 
Spacing Details the spacing between the support posts. 

Clicking the square button will 
launch the dialog box.  The 
spacing between posts may be 
varied within a certain range by 
clicking the increase or decrease 
triangles.  Clicking on the 
Standard button will select the 
standard spacing. 

 

 
 
 
 
 
 
 
 
 

 
Continued on next page 

Click the OK button to 
continue. 

Click the OK button to 
continue. 
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4.2.1 Support Details, (continued) 

 
Clearance 
Above Road 
Edge 

Details the height of the sign from the road surface to the bottom of the sign. 

Clicking the square button will 
launch the dialog box.  The 
height of the sign may be varied 
within a certain range by clicking 
the increase or decrease 
triangles. 

 

 
 
 
 
 
 
 
 
 
 

 
Distance From 
Carriageway 

Details the lateral clearance between the part of the sign nearest to the road and 
the edge of the kerb, or pavement. 

Clicking the square button will 
launch the dialog box.  The 
distance of the sign may be 
varied within a certain range by 
clicking the increase or decrease 
triangles. 

 

 
 
 
 
 
 
 
 
 
 
 

 
Continued on next page 

Click the OK button to 
continue. 

Click the OK button to 
continue. 
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4.2.1 Support Details, (continued) 

 
Post Lengths  

 

 

 

The length of the post nearest the kerb 
(not including section underneath slip 
base or screw footing). 

 

 

 

 

The length of the second, third and 
fourth nearest post to the kerb (not 
including section underneath slip base 
or screw footing). 

 

 

 

 

 
Stub Length  

 

 

 

 

The length of the post stub that sits 
inside the screw (if a screw footing is 
used), or that remains below the slip 
mechanism (if a slip is used). 

 

 

 
 

 
Continued on next page 
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4.2.1 Support Details, (continued) 

 
Post 
Dimensions 

 

 

 

 

For CHS, truss and strut posts, the 
measurement is the external diameter 
of the posts.  For RHS the 
measurement is the rectangular cross-
section of the post.  For truss supports, 
the additional measurement is the 
distance between the two vertical 
posts. 

 

 

 
Post Wall 
Thickness 

 

 

 

 

 

 

 

The thickness of the wall material. 

 

 
 
 
 

 
Continued on next page 
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4.2.1 Support Details, (continued) 

 
Post Grade  

 

 

 

 

 

 

 

The grade of steel used for the post. 

 

 

 

 
Slip Base 
Required 

 

 

 

 

 

 

 

 

Indicates previous selection (selected 
in 3.1.2). 

 

 

 
Continued on next page 
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4.2.1 Support Details, (continued) 

 
Stiffener Type  

 

 

 

 

 

 

 

Shows one of two types of stiffener, 
designated as Type 1 and Type 2. 
Refer to Standard Drawing ES – 126. 
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4.2.2 Footing Details 

 
Diameter of 
Hole/Screw 

Shows the diameter of the hole for normal concrete footings/diameter of screw. 

Clicking on the square button will 
launch the dialogue box. 

Select either Normal or Screw footing 

 

 

 

 

 

 

 

 

 

 
 
Depth of 
Hole/Length of 
Screw 

Shows the depth of hole from the 
surface to the end of the post, not 
including the depth of concrete 
underneath the post/length of screw. 

 

 

 

 

 

 

 

 

 

 

Click the OK button to 
continue. 
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4.2.3 Sign And Stiffener Details 

 
Sign and 
Stiffener 
Details 

Moving the cursor over each sign box 
displays a small window that shows 
information relevant to each sign face. 

To adjust the method by which the 
required number of stiffeners is 
calculated, select Stiffener Spacing 
options from the Edit menu 

 
 
 

 
Stiffener 
Spacing 
Options 

Selecting Stiffener Spacing options 
from the Edit menu will launch the 
Stiffener Spacing dialog box. 

Spacings and distances may be varied 
within a certain range by clicking the 
triangles. 

 

 
TraSiS automatically calculates 
the most efficient stiffener 
configuration base on the 
settings in this form. 

 
TraSiS contains the correct 
settings to conform to the Main 
Roads Guidelines ES – 126.  
Additionally, provision is made 
for users to specify custom 
settings by adjusting the values 
above and selecting the last 
button of the three: 

Use Custom Settings. 
 

 

 

 

 

 

Click the OK button to 
continue. 
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4.2.4 Post Type Selection 
 

Selection 
Guide 

Refer to the Design Guide for Roadside Signs, 8.3.2 for instructions on the 
selection of appropriate post sections. 

It is not always possible to construct a sign using a particular post type 

 
CHS Steel Specifies that the post(s) be made of circular hollow section. 

Refer to Standard Drawing 1363. 

 

 

 
RHS Steel Specifies that the post(s) be made of rectangular hollow section. 

Refer to Standard Drawing 1363. 

 

 

 
Truss Steel Each truss post comprises two vertical CHS posts connected by smaller CHS 

members that form a web, zigzagging down the length of the posts. 

Refer to Standard Drawings 1366 and 1367. 

 

 

 
Strut Steel Each strut is formed from two CHS posts, one vertical and the other at an angle to 

the ground. 

Strutted steel signs are not yet approved for use in Queensland 

 

 

 
Selection 
Guide 

Use the View 3D button to 
see the strut structure in 
relation to the ground. 
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4.2.5 Message Box 

 
Warnings 
and/or Errors 

The Message Box displays any warning or errors regarding the structural design. 
Most warnings are to inform that various aspects of the sign do not meet standard 
guidelines.  Others indicate that no standard sign structure is possible for the 
specified conditions. 

A list of errors may be found in Chapter 8 Warnings and Errors 

 

 

 

 

 

 

 

 

 

 

 

 

 
Status Bar Indicates the current operating status of program and provides status information 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
End of Chapter 4 
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CHAPTER 5 

SIGN STORAGE 
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Section 5.1 
Sign Storage 

 
5.1.1 Storage Department 

 
Database TraSiS stores all of its signs in a database format organised by job, section and 

location. 

 

 

 

 

 

 

 

 

 

 

 

 
Renaming To rename a Sign, Job Section or an entire Job, firstly click on the required folder 

icon in the stored signs area then click on to the name of the file, which will now 
become bolded.  Type in the new name as required and click the Rename button.

 

 

 

 

 

 

 

 

 

 

 

 

 
Continued on next page 

Job Code 

Job Section 

Sign Position 

File Name 

Folder Icon 

Type New 
Name 

Click the Rename 
button to continue. 
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5.1.1 Storage Department, (continued) 

 
Job 
Management 

The job management feature selects which jobs appear in the storage department 
windows, preventing the window from becoming crowded with older jobs. 

Clicking the Job Management 
button will launch a dialog box 
from where the job codes can 
be enabled (displayed in the 
Load a Sign Structural 
Design box) or disabled 
(hidden). 

Once modified, clicking the OK
button will close the dialog box. 

 

 

 

 

 

The Job Management dialog box 
shows the particular database location 
and permits relocation of files. 

The database that stores the signs can 
be found as a gsddb.mdb file, residing 
in the TraSiS directory. 

Extra databases can be developed, by 
copying, renaming and then editing the 
original database to suit.   

These databases may then be retained or transferred to other locations by 
copying the relevant database gsddb.mdb file.  Selection of a particular database 
can then be made from the relevant .mdb files in the TraSiS directory. 

 
Storage 
Commands 

The sign storage commands are accessible from the 
File menu, as discussed in 2.1.3. 

 
 
 
 
 
 
 
 

 
End of Chapter 5 
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Section 6.1 
Understanding Clear Zone 

 
6.1.1 Clear Zone Concept 

 
Purpose The purpose of the clear zone is to minimise the risk for errant motorists by 

establishing a minimum distance beside the road that ought to be clear of 
obstructions. 

TraSiS automatically calculates the appropriate clear zone distance for a roadside 
cross-section while taking into account parameters such as speed environment, 
road curvature and AADT. 

The clear zone distance is not a precise measurement; rather it is an indicative 
guide to assist in the application of engineering judgement to a particular situation.

Refer to Design Guide for Roadside Signs, 4.1. 

 

 

 

The clear zone module is launched 
from the Edit menu 
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Section 6.2 
Clear Zone Window 

 
6.2.1 Display 

 
What is Seen The window is divided into two main section; a graphical display of the roadside 

on the left and a column on the right that contains controls for the clear zone 
parameters and other data displays. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Graphical Display Controls 

Clear Zone 
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6.2.2 Parameters 

 
Road 
Curvature 

Use the check box to indicate whether the road is on a curve or not, and if so 
adjust the curve radius using the scroll bar.  Road curvature with radius greater 
than 900m is considered to be comparatively straight, while a minimum radius of 
curvature exists for each speed environment. 

 

 

 

 

 
Barrier 
Distance 

Specifies if a barrier is employed on the roadside, and if so the distance from the 
roadside to the barrier that can be adjusted using the scroll bar. 

 

 

 

 
Speed 
Environment 

Either the 85th percentile speed of all traffic on the road; or if this is unavailable 
then the posted speed limit. 

 

 

 
AADT Traffic volume in units of vehicles per day. 
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6.2.3 Clear Zone Distance 

 
Level Terrain The calculated clear zone distance for a level slope using the given parameters. 

 

 

 
Actual Terrain As above, but considering the slope details as specified for the sign location 

(3.1.10.  Currently no algorithm exists to calculate clear zone distance for sections 
with both cut and fill slopes, therefore in this circumstance TraSiS returns a 
message indicating that the slope section is too complicated to analyse. 

 

 

 
End of Chapter 6 
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Section 7.1 
Printing Forms 

 
7.1.1 Accessing the Print Commands 

 
Forms 
Available 

TraSiS includes three different print forms: 
1. Design Form; 

2. Order Form; and 

3. Summary Form. 

 

Select the appropriate form 
using the Print option from 
the File menu. 

 

 

Clicking on one of the three options available will launch the Print Job Selection 
Form shown below.  This procedure is common for printing any of the three 
forms, however, the procedure varies slightly form this point forward, as illustrated 
in the following. 
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7.1.2 How to Print Design and Summary Forms 
 

Print Selection On the Print Selection Job Form to select the sign for printing, follow the steps: 

1. Click the appropriate Job Code Section and Position; 

2. Information on the Current Print Status will appear; 

3. Click the Add button to locate the sign in the Signs Selected To Print box; 

4. Click the Print Setup button to set the printer requirements; 

5. This will then launch the Print Setup menu box; 

6. Select printer settings; 

7. Click OK to close the Print Setup box; 

8. Return to the Print Job Selection Form; and 

9. Select OK to print. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 
Continued on next page 
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7.1.2 How to Print Design and Summary Forms, (continued) 
 

Design Form The following is a sample Design Form. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Continued on next page 
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7.1.2 How to Print Design and Summary Forms, (continued) 

 
Design Form 
(cont'd) 

This Notes page is printed along with the Design Form. 
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7.1.2 How to Print Design and Summary Forms, (continued) 

 
Summary 
Form 

The Summary Form contains structural data for each sign in a condensed form 
under the headings: 

• Position Number; 

• Sign Code; 

• Sign Details; 

• Stiffener Details; 

• Support Details; 

• Support Length Details; 

• Stub; and 

• Footing Details. 

The form fits the details of up to forty signs per page, arranged according to Job 
Code and Section. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Traffic Sign Structures (TraSiS)  
User Manual 
 

  

 

 Chapter 7 – Printing TraSiS - User Manual 64 

7.1.3 How to Print Order Forms 

 
Order Form The Order Form contains all data necessary to order the correct structural 

members: 

• Requisition Number (see note below); 

• Job Code, Job Section and Sign Position; 

• Sign Face Details; 

• Stiffener Details; 

• Support Details; 

• Stub Details; and Fitting Details. 

Note: The form fits details of up to ten signs per page. 

•  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The print process includes a prompt for the requisition number that appears at the 
top of the page. 

 
End of Chapter 7 
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Section 8.1 
Understanding the Window 

 
8.1.1 Introducing Main Window 

 

Warnings and 
Errors 

TraSiS communicates warnings or errors through the Message Box.  Below are 
some commonly displayed warnings and errors. 

WWaarrnniinngg  oorr  EErrrroorr  PPrroobbaabbllee  CCaauussee  
Insufficient Terrain Information 
has been defined 

Total horizontal length of the roadside slope is less than the 
width of the sign face 

A combination of Large Sign Area 
and/or High Clearance Height has 
resulted in no solution being found 
for the stated Wind Region and 
Exposure settings 

This error generally occurs on signs with large areas and 
heights, especially with strut signs - not always literal 

Only 1 Front Sign is allowed for 
Truss Designs! 

The user attempting to view a truss structure for two or more 
sign faces 

Only Normal Concrete Footings are 
allowed for Truss Designs! 

The user attempting to use screw footings on a truss support 

Post 2 Clearance is "x" and needs 
to be at least 1500 

The minimum post clearance is required for the safety and 
courtesy of pedestrian traffic.   Post Clearance is calculated by 
subtracting 175 mm from the road height 

Post 1 Clearance is "x" and needs 
to be at least 2100 

As above, however greater clearance is required for slip-base 
signs 

Post 2 Clearance is "x" and needs 
to be less than 10000. 

The maximum post clearance for CHS and RHS posts is 10 m 

Post Spacing must be greater than 
1500 mm for Slip Base Supports – 
signs less than 1700 mm that 
require two posts may be excluded 

Post spacing is critical for only slip-base signs.  Note that for 
some situations it may not be possible to find a suitable design 
that can be built inside a clear zone 

Post Spacing is too wide for the 
Smallest Signs Width 

For a sign panel, the minimum overhang beyond the supports 
is 100 mm 

Post 2 Clearance is "x" and needs 
to be less than 3250 

The maximum post clearance for truss posts is 3250 mm 

Design Eccentricity too Large 
(Difference between Tallest and 
Shortest Posts) 

In a strut support sign, the difference in length of any two 
posts cannot be more than 500 mm 

Cross section data too complicated 
to analyse 

When the roadside cross section has both cut and fill slopes, 
this message appears in the clear zone window 

Sign Panel Height > Twice the 
Clearance height. A Slip Base 
Design is not possible for this 
situation! 

For slip-base designs, the clearance height must be more than 
half the sign panel height 

Sign is too wide to be handled by 
this program! 

Sign width must be less than, or equal to 9600 mm. 
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8.1.1 Introducing Main Window, (continued) 

 
Examples of 
Warnings  

The following illustrates typical examples of warnings. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
      
 
 
 
 
 
 
 
 
 

 
End of Warnings and Errors 
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HORTCUT KEYS  
 

 
Shortcut 
Functions 

Shortcut keys for commands are described in the table below: 

 

 

TToo  PPrreessss  
Open a new file  <Ctrl>+<N> 

Open an existing file <Ctrl>+<O> 

Close the current file <Ctrl>+<C> 

Save the current file <Ctrl>+<S> 

Save the current file as <Ctrl>+<A> 

Delete the current file <Ctrl>+<B> 

Exit TraSiS <Ctrl>+<F4> 

Print Design Form <Ctrl>+<D> 

Print Order Form <Ctrl>+<R> 

Print Summary Form <Ctrl>+<M> 

Edit Sign Details <Ctrl>+<L> 

Edit Environmental Conditions <Ctrl>+<E> 

Edit Stiffener Spacing <Ctrl>+<T> 

Edit Clear Zone <Ctrl>+<Z> 

Default Values <Ctrl>+<V> 

Obtain Help <Ctrl>+<G> 

 
End of Keyboard Shortcuts 
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LOSSARY  
 

 
Application A computer program.. 

 
Click The act of shortly pressing the left mouse button.  In Windows, this is the standard 

way of selecting an object.  For example, to select something, the pointer is 
moved over the object and then clicked. 

 
Clipboard A temporary storage space used to move text (or images) from one application to 

another, using the Copy, Cut, and Paste commands.  For example, the clipboard 
can be used to copy text from a word processor document and insert (paste) it 
into Station's handover notes. 

 
Double-click The act of momentarily pressing the left mouse button two times.  In Windows, 

this is the standard way of selecting an object and performing an action.  For 
example, to display the details about a particular alphanumeric, the pointer is 
moved over the alphanumeric and then double-clicked - this displays a window 
that shows the object's details. 

 
Drag A standard technique of moving or resizing an object.  For example, to drag an 

object to a new location, the following procedure is followed: 

Move the pointer over the object to drag. 

Click and hold down the mouse button. 

Move the pointer to the new location and release the mouse button. 

 
Status Line  The line below the display, which shows various types of status information. 

 
End of Glossary 
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NDEX  
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cut · See Glossary 
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Data field Adjustment · 35 
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Document List · 12 
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E 
Edit Menu · 20 

F 
File Menu · 18 

H 
Help Menu · 21 

I 
Installing TraSiS · 15 

J 
Job Details · 25 
Job Management · 50 

K 
keyboard 

shortcuts to commands · 71 

M 
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P 
paste · See Glossary 
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Post Spacing · 36 
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Soil Description · 30 
Soil Type · 29 
Speed Environment · 55 
Status Bar · 45 
status line · See Glossry 
Stiffener Spacing Options · 43 
Stiffener Type · 41 
Storage Commands · 50 
Stub Length · 38 
Summary Form · 63 
Support Details · 36 

T 
Terrain · 56 
TypographicalConventions · 10 

W 
Warnings and Errors · 67 
Warnings and/or Errors · 45 
warnings or errors · 67 
Wind Region · 28 
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